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Every October, Deltek identifies and assesses the top 
10 small business federal contract opportunities for 
the new fiscal year.

The FY 2026 Top 10 small business opportunities total 
contract value is approximately $45.0 B, consisting of 
prime contract opportunities from a variety of 
agencies and industry segments.

This report reveals key trends and patterns in the 
procurements as compared to prior years to assist 
vendors in their business development.

Purpose of this Report
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» Drawn from Deltek’s GovWin IQ 
Federal Opportunities database

» Vetted by Deltek’s team of 
analysts

» Bellwether opportunities for the 
coming fiscal year

» Determined by total expected 
contract value or anticipated 
ceiling value

» Estimated solicitation dates in 
fiscal year 2026

» Opportunities are 100% set-
asides

» Deltek RFP estimated dates are based on our 
analysis of the earliest potential RFP release 
date by the government to ensure industry does 
not miss any procurement activity. As a result, 
dates will frequently shift as the government 
solidifies its acquisition plans.

» The assigned values may vary between 
published values, government estimates and 
Deltek estimated values. For its estimated 
values, Deltek reports the highest possible 
contract value for any opportunity.

» The report is intended to be viewed in 
presentation mode for better readability and 
hyperlink enablement.

Reminders

Scope
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Receipts Employees Planned Changes

“Total income” (or “gross income”) plus the 
“cost of goods sold.” Numbers can be 
found on the business’s IRS tax return 

forms.

Averaged receipts over latest 3 or 5 
complete fiscal years. If in business less 

than 5 years, multiply average weekly 
revenue by 52

All individuals employed on a full-time, 
part-time, or other basis; includes 

temporary employees and employees of its 
domestic and foreign affiliates.

Average number of employees for each of 
the pay periods for the preceding 

completed 12 calendar months. If in 
business less than 12 months, then use 
employee count for each pay periods 

during in business

» Proposed Rule issued August 22, 2025
» Comment Period ends October 21, 

2025
» 450+ Codes Receipt-based codes 

reviewed
» 200+ will increase
» 1 will be eliminated
» Zero will decrease
» Rest remain the same

Planned Increases to 200+ Receipt-Based Size 
Standards

5© Deltek, Inc. All Rights Reserved.

If average above results = 
Large Business

If average below results = 
Small Business

Most services and some product 
size standards are receipt-based, 

manufacturing is usually 
employee-based

Recommended Resources
Federal Register: Small Business Size 

Standards: Monetary-Based Industry Size 
Standards

SBA Table of Small Business Size Standards

Sources: 13 CFR 121.104, 13 CFR 121.106; Federal Register, SBA

https://www.federalregister.gov/documents/2025/08/22/2025-16142/small-business-size-standards-monetary-based-industry-size-standards
https://www.federalregister.gov/documents/2025/08/22/2025-16142/small-business-size-standards-monetary-based-industry-size-standards
https://www.federalregister.gov/documents/2025/08/22/2025-16142/small-business-size-standards-monetary-based-industry-size-standards
https://www.federalregister.gov/documents/2025/08/22/2025-16142/small-business-size-standards-monetary-based-industry-size-standards
https://www.federalregister.gov/documents/2025/08/22/2025-16142/small-business-size-standards-monetary-based-industry-size-standards
https://www.sba.gov/document/support-table-size-standards


SDB Year-over-Year Prime Contracting Goal Increase 
Scaled Back to 5% for FY 2025
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Find in GovWin: Agency Profiles



Rule of Two (2)
8(a) Sole Source 

(or not)
Required Use 

Vehicles
Statute remains in place for 

contracts: when 2 or more SBs 
can provide the supplies or 
service between the micro-

purchase threshold (MPT) ($20K 
for US, $35K for outside US) and 
Simplified Acquisition Threshold 

(SAT) ($350K)

FAR Council retained rule for 
acquisitions above SAT

Does NOT apply to Task Orders, 
up to contracting officer’s 

discretion and not a basis for a 
protest

If acquisition is below the 
competitive threshold ($8.5M 

for manufacturers; $5.5M for all 
other baselines) contracting 

officers must first try a 
competitive task order 

acquisition using SBA-approved 
vehicles BEFORE considering 

8(a) sole source awards

The Office of Procurement 
Policy (OFPP) will designate 
contracts as “required use.” 

These contracts are mandatory, 
unlike Best-In Class (BICs), 

which are strongly preferred but 
not required.

For use when BICs don’t fit the 
requirements and to avoid the 
agency creating new contracts 
when there may be an existing 

one in place.

Notable Revolutionary FAR Overhaul (RFO) aka FAR 2.0 
Changes
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Recommended Resource

FAR 2.0 Webinar Series
» On Demand:

» Demystifying FAR 2.0: 
Understand the Revolutionary 
FAR Overhaul

» FAR 2.0 Critical Update: New 
Developments You Can't Miss

» FAR 2.0 Fall Update: 
September Implementation 
Insights

» Regulations / policies may 
have changed since recorded

» October 9, 2025: FAR 2.0 October 
Update: Latest Developments

Revolutionary FAR Overhaul (RFO)

FAR Parts and Agency Deviations

FAR Part 19 – Small Business Change 
Summary

Executive Order # 14275, Restoring 
Common Sense to Federal 

Procurement

https://event.on24.com/wcc/r/5096987/BDA7164035A5A2C72593C519DBACA8D0/6241890?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://www.acquisition.gov/far-overhaul
https://www.acquisition.gov/far-overhaul/far-part-deviation-guide
https://www.acquisition.gov/sites/default/files/practitioner_albums/far-part-19-small-business/content/index.html#/lessons/pzmmmTfgtBI4eMQ32Cw9ppirRJkpJcD3
https://www.acquisition.gov/sites/default/files/practitioner_albums/far-part-19-small-business/content/index.html#/lessons/pzmmmTfgtBI4eMQ32Cw9ppirRJkpJcD3
https://www.acquisition.gov/sites/default/files/practitioner_albums/far-part-19-small-business/content/index.html#/lessons/pzmmmTfgtBI4eMQ32Cw9ppirRJkpJcD3
https://www.acquisition.gov/sites/default/files/practitioner_albums/far-part-19-small-business/content/index.html#/lessons/pzmmmTfgtBI4eMQ32Cw9ppirRJkpJcD3
https://www.whitehouse.gov/presidential-actions/2025/04/restoring-common-sense-to-federal-procurement/
https://www.whitehouse.gov/presidential-actions/2025/04/restoring-common-sense-to-federal-procurement/
https://www.whitehouse.gov/presidential-actions/2025/04/restoring-common-sense-to-federal-procurement/


All But One of the Top Multiple Award IDIQs for SB Set-Asides are 
Owned or (Planned to be) Operated by the GSA

FY 2025 Spending does not reflect Q4 Defense due to 90-day reporting delay; Source: Deltek
Find in GovWin: Federal Spending Analytics (FSA)

Top 5 Multiple-Award Contract Vehicles with Small Business Set-Asides, based on Contract Obligations 
FY 2021 – FY 2025* ($B)

FY 
2021

FY 
2022

FY 
2023

FY 
2024

FY 
2025*

Primary 
Industry

Program Status
GovWin 
Opp ID

SEWP IV / V $6.80 $7.09 $8.50 $8.64 $7.74 IT
SEWP VI pending award. Upon award, expected to transition to a GSA 

operated vehicle.
201788

GSA MAS $5.79 $6.95 $8.48 $9.50 $7.83 Multi
Proposals continually received; contracts continually awarded. 

Consolidation of most former stand-alone schedules. Many industries 
represented, though most spending for Professional Services.

n/a

OASIS / OASIS+ All 
SB Versions

$4.19 $5.05 $5.62 $5.75 $4.95 Prof Svcs

Multiple IDIQs based on competition type - UNR, 8a, SDVOSB, 
HUBZone, WOSB, and SB for OASIS+. Many contracts already awarded, 

more contracts will be awarded. 
Phase II planning started, expected to additional domains (i.e., folding in 

the BMO and portions of HCaTS)

201043

SOE TLS $1.26 $2.04 $2.82 $3.17 $3.20 Prof Svcs
This is DLA’s Special Operational Equipment (SOE) Tailored Logistics 

Support  (TLS) Program. Awarded to 36 contractors in 2021 for 10-year 
contract. On Ramp not expected.

126549

CIO-SPx UNR / SB $1.75 $2.15 $2.14 $2.00 $1.97 IT

Follow-on CIO-SP4 (still) under protest. There were 357 GAO protests 
and now under litigation with US Court of Federal Claims. Current 

contracts extended to April 2026. Upon award, expected to transition 
to a GSA operated vehicle.

177161

Recommended Resource
Executive Order 14240, Eliminating Waste and Saving 

Taxpayer Dollars by Consolidating Procurement
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https://iq.govwin.com/neo/opportunity/view/201788
https://iq.govwin.com/neo/opportunity/view/201043
https://iq.govwin.com/neo/opportunity/view/126549
https://iq.govwin.com/neo/opportunity/view/177161
https://www.whitehouse.gov/presidential-actions/2025/03/eliminating-waste-and-saving-taxpayer-dollars-by-consolidating-procurement/
https://www.whitehouse.gov/presidential-actions/2025/03/eliminating-waste-and-saving-taxpayer-dollars-by-consolidating-procurement/


What is it?
» Cybersecurity Maturity Model Certification (CMMC) 

ensures contractors protect:
» Federal Contract Information (FCI)
» Controlled Unclassified Information (CUI)

» Key DFARS Clauses:
» 252.204-7021 – Inserts CMMC requirements into 

contracts.
» 252.204-7025 – Supports implementation. 

When is it? 
» Phase 1 Begins: November 10, 2025
» Launches a 3-year rollout of cybersecurity requirements 

for DoD contracts.
» Years 1-3: Requirements apply only when program 

offices specifically determine a CMMC requirement 
is needed 

» Year 4 and beyond: Requirements apply to all 
contracts involving FCI or CUI processing, except 
exclusively COTS (commercial off-the-shelf) items

» Full Compliance: Required by Year 4 (2028).
Requirements:
» CMMC Level 1 & 2 included in new contracts.
» Contractors must self-assess and submit scores to SPRS 

(Supplier Performance Risk System).
What do YOU need to do? 
» Maintain NIST SP 800-171 implementation.
» Update SPRS scores.
» Determine applicable CMMC level.
» Identify and address cybersecurity gaps.

Three CMMC Levels:

» Level 1: Basic Safeguarding of FCI = Annual 

self-assessment and annual affirmation of 

compliance with the 15 security 

requirements in FAR clause 52.204-21.

» Level 2: Broad Protection of CUI = Either a 

self-assessment or a C3PAO assessment 

every three years, as specified in the 

solicitation. Decided by the type of 

information processed, transmitted, or 

stored on the contractor or subcontractor 

information systems. Annual affirmation, 

verify compliance with the 110 security 

requirements in NIST SP 800-171 Revision 2.

» Level 3: Higher-Level Protection of CUI 
Against Advanced Persistent Threats = 

Achieve CMMC Status of Final Level 2. 

Undergo an assessment every three years 

by the Defense Contract Management 

Agency’s Defense Industrial Base 

Cybersecurity Assessment Center 

(DIBCAC). Provide an annual affirmation 

verifying compliance with the 24 identified 

requirements from NIST SP 800-172.

CMMC 2.0 Live November 10, 2025!
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Level 1 Self-
assessment, 

142,487

Level 2 Self-
assessment, 4,596

Level 2 
Certificate, 

80,436

Level 3 
Certificate, 

2,298

DOD’s Estimated Count 
Impacted SBs by CMMC Level*

*Counts based on DOD formulas found in DFARS Case 2019-D041
Source: DOD CIO CMMC, DFARS Case 2019-D041

Recommended Resources
Federal Register: Defense Federal Acquisition Regulation 

Supplement: Assessing Contractor Implementation of 
Cybersecurity Requirements (DFARS Case 2019-D041)

DOD CIO About CMMC
CMMC Compliance: Program Updates That Could Make or 

Break Your Contracts
On Demand webinar presented by Deltek

Regulations / policies may have changed since recorded

https://www.federalregister.gov/documents/2025/09/10/2025-17359/defense-federal-acquisition-regulation-supplement-assessing-contractor-implementation-of
https://www.federalregister.gov/documents/2025/09/10/2025-17359/defense-federal-acquisition-regulation-supplement-assessing-contractor-implementation-of
https://www.federalregister.gov/documents/2025/09/10/2025-17359/defense-federal-acquisition-regulation-supplement-assessing-contractor-implementation-of
https://www.federalregister.gov/documents/2025/09/10/2025-17359/defense-federal-acquisition-regulation-supplement-assessing-contractor-implementation-of
https://www.federalregister.gov/documents/2025/09/10/2025-17359/defense-federal-acquisition-regulation-supplement-assessing-contractor-implementation-of
https://dodcio.defense.gov/CMMC/About/
https://event.on24.com/wcc/r/5062295/56E273658090C58285F8DD1583793489?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/5062295/56E273658090C58285F8DD1583793489?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007


Top 10 Small Business
Opportunities FY 2026
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Frame this one with gradient meshFrame this one with gradient mesh

FY 2026 Top 10 Small Business Quick Reference List
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Rank Agency Program Name
RFP 
Date

Award 
Date

Est. 
Value

GovWin 
IQ ID

1 DOD DIA Solutions for Intelligence Analysis 3 Small Business On Ramp (SIA 3) 12/2025* 06/2026* $17.1 B 247496

2 DHS DHS Wide Temporary Facilities and Services 11/2025* 03/2026* $7.5 B* 247482

3 Army Prototype Integration Facility PIF 2027 (PIF IV) 01/2026 11/2027* $6.0 B 240066

4 HHS HHS One Professional Services Solution (HOPSS) 05/2026* 04/2027* $3.6 B* 249137

5
DOD 

USSOCOM
SOF Global Services Delivery (SOFGSD)

11/2025
05/2026* $3.2 B 207172

6 DHS
Cellular Wireless Managed Services for the Department of Homeland 

Security 3 (CWMS 3.0) 11/2025*
03/2026* $3.1 B 244497

7 Air Force Technical and Management Advisory Services for the Test Enterprise 
(TMAS 3) 10/2025

07/2026 $1.5 B* 238686

8 Commerce Census Bureau Transformation Application Modernization (CENTAM) 12/2025* 06/2026* $1.0 B 237323

9 Air Force
Special Operation Forces Multiple Award Contract for Modifications 

(SOF/PR)(MACM) 03/2026*
10/2026* $996 M* 231499

10 Navy Engineering Technical Support for Code 434 Habitability Program 03/2026* 06/2027* $986 M* 246373

* Deltek Estimate

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/247482
https://iq.govwin.com/neo/opportunity/view/240066
https://iq.govwin.com/neo/opportunity/view/249137
https://iq.govwin.com/neo/opportunity/view/207172
https://iq.govwin.com/neo/opportunity/view/244497
https://iq.govwin.com/neo/opportunity/view/238686
https://iq.govwin.com/neo/opportunity/view/237323
https://iq.govwin.com/neo/opportunity/view/231499
https://iq.govwin.com/neo/opportunity/view/246373


What You Should Know

Deltek confirmed this is a new requirement; therefore, there are no incumbents.

Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

Solutions for Intelligence Analysis (SIA 3)
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Opp ID # 247496
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» Top Secret clearance with Sensitive Compartmented 
Information (SCI) access required

» Any awards will be sharing in the overall SIA 3 ceiling ($17.1B), 
and the duration will line up to expire with the original 
awardees (August 2029)

» The acquisition will use the Acquisition Resource Center 
(ARC) portal due to the sensitive nature of the requirement

» Contract (task order) types include Time and Materials (T&M), 
Fixed Price, and Cost

» Only one original awardee (Black Hawk) remains a small 
business under NAICS 541990 (Size Standard $19.5M)

541990, All Other Professional, Scientific & Technical Svcs

Professional Services

10/2025 (Deltek Estimate)
01/2026 (Deltek Estimate)

$17.1 Billion (Government Estimate)
Small Business

Defense Intelligence Agency

The Defense Intelligence Agency (DIA) seeks to expand the small 
business pool of contractors to fulfill the Solutions for Intelligence 
Analysis (SIA 3) mission of operational agility of the Defense 
Intelligence Enterprise (DIE) with tailored acquisition support for 
Intelligence Analysis and Analytic Enabling services.

Due to the sensitive nature of the work, contract spending data is not available

https://iq.govwin.com/neo/opportunity/view/247496
https://www.nsaarc.net/dashboard
https://www.nsaarc.net/dashboard


SIA III Labor Categories
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Opp ID # 247496

ANALYSIS
» Air Systems Analyst
» All Source Analyst
» Biological Weapons (BW) Analyst
» Biometrics / Identity Intelligence (I2) 

Analyst
» Chemical Weapons (CW) Analyst
» Command, Control, Communication, 

Computers & Intelligence (C4I) 
Analyst

» Counterdrug (CD) / Transnational 
Organized Crime (TOC) Analyst

» Counterintelligence (CI) Analyst
» Counterterrorism / Insurgency 

Analyst
» Cyber Analyst
» Defense Industry Analyst
» Denial and Deception (D&D) Analyst
» Economic Analyst
» Electronic Intelligence (ELINT) 

Analyst
» Emerging and Disruptive Technology 

Analyst
» Energy Analyst
» Geospatial Analyst
» Ground Systems Analyst
» Imagery Intelligence (IMINT) Analyst
» Logistics / Transportation Analyst
» Measurements and Signatures 

Intelligence (MASINT) Analyst
» Medical Intelligence Analyst
» Military Forces Analyst
» Missiles System Analyst

» Naval / Maritime / Naval Infantry 
Analyst

» Nuclear Systems Analyst
» Nuclear Weapons Analyst
» Open Source Intelligence (OSINT) 

Analyst
» Political Military Analyst
» Prisoner of War (POW) / Missing In 

Action (MIA) Analyst
» Proliferation Analyst
» Signals Intelligence (SIGINT) Analyst
» Social Media and Crowd-Sourced 

Data (SMCDA) Analyst
» Social Network Analyst
» Socio-Cultural Analyst
» Space / CounterSpace Analyst
» Target Materials (TM) Analyst
» Targeting Analyst
» Technical Intelligence (TECHINT) 

Analyst
» Technical SIGINT Analyst
» Technology Analyst
» Threat Finance Analyst
» Underground Facility (UGF) Analyst
» Warning Analyst
» Watchlist Analyst
» Weapons Systems Analyst
» Weapons of Mass Destruction 

(WMD) Analyst

ENGINEERING
» Aerospace Engineer

» Biomedical Engineer

» Chemical Engineer

» Civil / Industrial Engineer

» Data Engineer

» Electrical Engineer

» Geotechnical / Geophysical 

Engineer

» Mechanical Engineer

» Modeling and Simulations 

(M&S) Engineer

» Naval Architect

» Nuclear Engineer

» Textile Engineer

CI / HUMINT / COLLECTIONS
» CI Specialist

» CI / HUMINT Source Manager

» Collection Manager

» Collection Operations Manager

» Collection Strategist

» HUMINT Network Developer / 

Analyst

» HUMINT Targeting Specialist

» Signature Reduction Specialist

» Technology Targeting 

Specialist

SCIENCES
» Agronomist
» Behavioral Scientist
» Biologist
» Cartographer
» Chemist
» Computer Scientist
» Data Scientist
» Decision Scientist
» Epidemiologist
» Geologist
» Hydrologist
» Imagery Scientist
» Oceanographer
» Operations Research 

Systems Analyst 
(ORSA)

» Physicist
» Space Scientist / 

Atmospheric Scientist
» Statistician / 

Mathematician

ANALYTIC ENABLING
» Analytic Facilitator

» Analytic Methodologist

» Analytic Tradecraft 

Compliance Specialist

» Business Process Specialist

» Computer Forensics 

Specialist

» Content Editor

» Disclosure Representative

» Dissemination Specialist

» Graphics Developer / 

Designer

» Intelligence Management 

Specialist

» Intelligence Planner

» Knowledge Manager

» Program / Project Manager 

(PM)

» Risk Mitigation Specialist

» Social Science 

Methodologist

» Special Security Technician

» Targeting Automation 

Specialist

» Technical Editor

Experience Levels: Junior Mid Senior Expert

https://iq.govwin.com/neo/opportunity/view/247496


Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

What You Should Know

Spending Analysis ($000) Competitive Analysis ($000)

DHS Wide Temporary Facilities and Services

14

Opp ID # 247482
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561210, 531120, 541611, and 541614

DHS

11/2025 (Deltek Estimate)
03/2026 (Deltek Estimate)

$7.5 Billion (Deltek Estimate)
Small Business (GSA MAS BPA)

Facility Support Services

The Department of Homeland Security (DHS) may have a continuing 
requirement for temporary facilities and services for the entire 
department.  The immediate requirements at the outset of the initial 
award was the southern border, but the place of performance is 
available to the US and its territories.

» The original award value was $3.5 Billion; this was increased at the On Ramp 
to $7.5 Billion

» Of the 5 awardees, Deployed Resources, Ranger Land Systems and Active 
Deployment systems are no longer small businesses under the related 
NAICS

» Caduceus Healthcare Inc. is small under NAICS 561210, 531120 and 
541611 but not 541614

» Vantage International Partners, LLC remains small under all 4 NAICS
» The previous BPA and On Ramp were solicited through the GSA MAS under 

the following Special Identification Numbers (SINs):
» 541614 - Deployment, Distribution and Transportation Logistics 

Services
» 561210FAC - Complete Facilities Maintenance and Management
» 532490P - Lease/Rental of Pre-Engineered/Prefabricated Buildings 

and Structures

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/247482


What You Should Know

Spending 
Analysis ($000)

Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

The current contract 
is held by Defense 

Systems and 
Solutions

Rapid Response Hardware Solutions for the 
Prototype Integration Facility 2027 (PIF IV)

15

Opp ID # 240066
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» DRFP was issued October 2024; a Sources Sought Notice was 
issued in November 2024

» Solicitation originally expected October 1, 2025, was pushed 
out to January 5, 2026 in a July 2025 Special Notice

» Solicitation documents may be released on the Procurement 
Integrated Enterprise Environment  (PIEE) procurement portal

» Incumbent Defense Systems and Solutions is a joint venture 
between Yulista Integrated Solutions, LLC (YIS) and Science 
and Engineering Services, LLC (SES).

» Yulista Integrated Solutions exited the 8a program in 
August 2023

» Over 300 task orders were awarded against incumbent 
contract

» More than 350 unique subcontractors reported with 
more than 1,200 unique actions

336413, Other Aircraft Part & Auxiliary Equipment Manufacturing

Army

01/2026 (Government Estimate)
11/2027 (Deltek Estimate)

$6.0 Billion (Government Estimate)
8(a)

Aircraft & Airport Equipment

The Army Futures Command (AFC) DEVCOM Aviation and Missiles 
Center (AvMC) is conducting a follow-on procurement to provide rapid 
response hardware solutions on behalf of the Prototype Integration 
Facility (PIF) at Redstone Arsenal, Alabama. Capabilities required to 
perform these services include, but are not limited to design and analysis, 
modeling and simulation, rapid prototyping, mechanical fabrication, 
comprehensive program management, research and development, 
engineering, fabrication, and subsystem/system integration. 

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/240066
https://piee.eb.mil/
https://piee.eb.mil/


Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

What You Should Know

Spending Analysis ($000) Competitive Analysis ($000)

HHS One Professional Services Solution 
(HOPSS)

16

Opp ID # 249137
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541690, Other Scientific and Technical Consulting Services

HHS

05/2026 (Deltek Estimate)
04/2027 (Deltek Estimate)

$3.6 Billion (Deltek Estimate)
Small Business

Professional Services

The Department of Health and Human Services, National Institutes 
of Health, has a requirement for One Professional Services Solution 
(HOPSS). Through this effort, contractors will provide a range of 
professional services in support of the HHS mission and strategic 
plan for functions related to STEM and the business and operational 
services to support STEM activities.

» Follow-on to the Scientific, Operations, and 
Administrative Resources (SOAR) opportunity

» Procured using full and open competition
» None of the 5 incumbents are small businesses 

under NAICS 541690 (size standard $19.0 
million)

» SOAR was NIH-specific, HOPSS will be HHS-wide
» Value based on incumbent contract total award value, 

HOPSS expected to be higher value due to expansion to 
all HHS

» Incumbent contracts were extended to now expire in 
2027

» Acquisition timeline delayed due to potential 
reorganization of the Acquisition Office

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/249137


Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

What You Should Know

Spending Analysis ($000) Competitive Analysis ($000)

Special Operations Forces Global Services 
Delivery (SOFGSD)

17

Opp ID # 207172
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541611, Admin Mgmt & General Mgmt Consulting Svcs

DOD USSOCOM

11/2025 (Government Estimate)
05/2026 (Deltek Estimate)

$3.2 Billion (Government Estimate)
Small Business

Professional Services

The Department of Defense (DoD), U.S. Special Operations 
Command (USSOCOM), has a requirement for Special Operations 
Forces (SOF) Global Services Delivery (SOFGSD). » Follow-on to SOF Core Support (SCS) which itself was 

formerly known as SOCOM-Wide Mission Support (SWMS)
» The SCS contract was for a 5-year base + one 3-year 

option + one 2-year option – expiring September 2030 
all options exercised

» Deltek does not believe the remaining options will be 
exercised

» 46 incumbent contracts – only 15 planned contracts for 
follow-on

» On / Off Ramps may occur
» Due to the nature of the work and agencies involved, not all 

task order activity was reported publicly under the current 
contracts

» A Top Secret Clearance may be required
» Will require Prime and Subcontractors to meet CMMC Level 1 

Self-Assessment requirement by proposal submission date

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/207172


What You Should Know

Spending 
Analysis ($000)

Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

The current contract 
is held by WidePoint 
Integrated Solutions 

Corporation

Cellular Wireless Managed Services 
(CWMS 3.0)

18

Opp ID # 244497

© Deltek, Inc. All Rights Reserved.

» The original ceiling for CWMS 2.0 was $500 million, later 
increased to $754 million in June 2024 for the 5-year total 
duration

» CWMS 3.0 will have a $3,066,613,353.66 ceiling for a 
10-year total duration, per June 2025 Draft

» The previous competition resulting in a single award. 
CWMS 3.0 will be a multiple award

» NAICS 517121 replaced retired code NAICS 517911 used 
for CWMS 2.0

» Both codes have same title and size standard: 
Telecommunications Resellers, 1,500 employees

» Prime Contractor or all Teaming Partners proposed in a JV 
or Mentor Protégé response must have an active Facility 
Clearance at the Top Secret level

517121, Telecommunications Resellers

Homeland Security

11/2025 (Deltek Estimate)
04/2026 (Deltek Estimate)

$3.1 Billion (Government Estimate)
Small Business

Communications Services

The Department of Homeland Security (DHS) requires continuing 
comprehensive commercial cellular wireless managed services.  The 
services include access to multiple carriers and services; a web 
portal customized to each component to manage and report on the 
complete lifecycle of a device from order placement to recycling, 
program management services to oversee all aspects of the 
program, and a robust service desk to support all employees.  

https://iq.govwin.com/neo/opportunity/view/244497


Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

What You Should Know

Spending Analysis ($000) Competitive Analysis ($000)

Technical and Management Advisory Services 
for the Test Enterprise (TMAS 3)

19

Opp ID # 238686

© Deltek, Inc. All Rights Reserved.

541715 (R&D) & 541330 (Engineering), both under exception 1

Air Force

10/2025 (Government Estimate)
07/2026 (Government Estimate)

$1.5 Billion (Deltek Estimate)
Small Business (OASIS+ SB)

Research & Development

TMAS 3 (Test & Management Advisory Services 3) is the Air Force 
Test Center’s (AFTC) enterprise-wide contract vehicle for acquiring 
Management and Advisory Services. This contract provides 
professional services support across key AFTC locations, including 
Edwards AFB, Eglin AFB, and the Arnold Engineering Development 
Complex (AEDC). 

» Four (4) FOPRs issued under Two (2) OASIS+ Small 
Business CLINs:

» 10302 - NAICS 541330 Ex 1 - Research and 
Development
» 412th Test Wing (412 TW) 

» 10311 - NAICS 541715 Ex 1 - Research and 
Development
» 96th Cyberspace Test Group (96 CTG)
» 96th Test Wing (96 TW)
» Arnold Engineering Development Complex 

(AEDC)
» See GovWin Opp ID # 229756 for more information 

on OASIS+ SB
» Value estimate based on combined award totals for all 

incumbents

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/238686
https://iq.govwin.com/neo/opportunity/view/229756


What You Should Know

Deltek confirmed this is a new requirement; therefore, there are no incumbents.

Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

Census Bureau Transformation Application 
Modernization (CenTAM)

20

Opp ID # 237323
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» Four planned Blanket Purchase Agreements (BPAs)
» Enterprise (multiple award)
» Decennial (single award)
» Geospatial (single award)
» Systems and Program Support (SPS) (multiple award)

» BPAs will be based off the based off the GSA Consolidated 
Multiple Award Schedule (MAS), under SIN 54151S, 
Information Technology Professional Services

» Previously focused on the Decennial program, expanded to 
USCB Enterprise Wide

» Though not included in the August 2025 announcement, the 
2024 Questions and Answers indicated the clearance 
requirements will be the Census BI for non-sensitive public 
trust clearance (T1/Low Tier)

» Industry is highly encouraged to collaborate and form teaming 
arrangements to respond to the future solicitation.

541511, Custom Computer Programming Services

Information Technology

12/2025 (Deltek Estimate)
06/2026 (Deltek Estimate)

$1.0 Billion (Government Estimate)
Small Business (GSA MAS BPA)

Commerce

The U.S. Department of Commerce, Census Bureau (USCB) has a 
requirement for an enterprise-wide framework that will support the 
modernization and development of applications across the USCB 
enterprise, including business, IT, economic, demographic, 
geospatial, decennial, and research programs.

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/237323


Enterprise Decennial Geospatial
Systems and Program 

Support (SPS)

Description
Supports large-scale efforts 

across all programs
Focuses on the 

Decennial Program
Focuses on the Geography 

Support Program
Supports smaller-scale efforts 

across all programs
# BPAs Awarded Multiple Single Single Multiple
Program Area(s) 

Supported
USCB-Wide Decennial Only Geospatial Only USCB-Wide

Task Areas 
Covered

All 5 Task Areas All 5 Task Areas All 5 Task Areas Only Task Areas 1-3

Phase 1 
Submission 

Topics

• Application Modernization using Open 
Source

• Cloud Application Modernization
• Advanced Data Science including 

Artificial Intelligence & Machine 
Learning (AI/ML)

• Organizational Change Management 
& Training

All topics under Enterprise PLUS
• Decennial Contract Management & Staffing

All topics under Enterprise 
PLUS
• Geospatial Data 

Management
• Geospatial Application and 

Data Modernization

• Systems Engineering & 
Architecture Corporate 
Certifications

• Architecture and Engineering
• IT Project and Program 

Management for 
Transformation

Phase 2 
Submission 

Topics

• Enterprise Contract Management, 
Teaming & Staffing

• Data Ingestion
• Data Collection, Processing, and Data 

Quality
• Technical Solution Challenge

All topics under Enterprise PLUS
• SAFe
• Data Architecture and Governance
• System of Systems Design and Architecture
• Security
• Questions for Key Personnel
• AI/ML Challenge

All topics under Enterprise 
PLUS
• Developing and/or 

managing a large and 
complex geospatial 
database

• SPS Contract Management & 
Staffing

• Program Level Testing
• Systems Engineering and 

Architecture

Conflict of 
Interest

• Optional Prime Decennial, Geospatial
• Cannot Prime or Sub SPS

• Must Prime Enterprise
• Optional Prime Geospatial
• Cannot Prime or Sub SPS

• Must Prime Enterprise
• Optional Prime Decennial
• Cannot Prime or Sub SPS

• Cannot Prime or Sub 
Enterprise, Decennial or 
Geospatial

CenTAM BPA Framework Cheat Sheet

21© Deltek, Inc. All Rights Reserved.

Opp ID # 237323

Source: August 2025 Special Notice

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/237323


Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

What You Should Know

Spending Analysis ($000) Competitive Analysis ($000)

Special Operation Forces Multiple Award 
Contract for Modifications (SOF/PR)(MACM)

22

Opp ID # 231499
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336411, Aircraft Manufacturing

Air Force

03/2026 (Deltek Estimate)
10/2026 (Deltek Estimate)

$996 Million
Small Business

Aircraft and Airport Equipment

The Department of the Air Force, Air Force Materiel Command, Air 
Force Life Cycle Management Center, ISR/SOF Directorate, Special 
Operations Forces/Personnel Recovery (SOF/PR) and Rotary 
Division has a requirement for modification and sustainment support 
for SOF/PR and Rotary managed C-130, H-1, and H-60 aircraft, to 
include integrated weapon systems, subsystems, and associated 
support equipment.

» The previous competition issued a single solicitation for 
two pools; offers could bid on either or both pools:

» Pool A - Fixed Wing C-130J Beyond Line of Sight 
(BLOS) Data Link 

» Pool B - Rotary Wing HH-60G BLOS Data Link
» Three (3) contracts were awarded for Pool A, two (2) for 

Pool B, and seven awardees (7) held both pools
» The requirements did not include Advisory and Assistance 

Services (A&AS) support
» At time of award the requirements included these 

platforms:
» Fixed Wing: AC-130U/W/J, EC-130J, HC-130N/P/J, 

and MC-130H/P/J
» Rotary Wing HH-60G, TH-1H, and UH-1N

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/231499


Primary Requirement:
NAICS Code: 

Buying Organization:
Solicitation Date:
Award Date: 
Value: 
Competition Type: 

What You Should Know

Spending Analysis ($000) Competitive Analysis ($000)

Engineering Technical Support for Code 434 
Habitability Program

23

Opp ID # 246373
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336611, Ship Building and Repairing

Navy

03/2026 (Deltek Estimate)
06/2027 (Deltek Estimate)

$986 Million (Deltek Estimate)
Small Business

Ship Building

The Department of the Navy, Naval Sea Systems Command, Naval 
Surface Warfare Center, Philadelphia Division, has a continuing 
requirement for Engineering Technical Support for Code 434 
Habitability Program.

» Secret clearance required for both personnel and 
facilities

» Expect multiple award IDIQ, Cost Reimbursement type 
contract

» For the five-year total contract period, 1,758,047 hours 
of technical support expected

» With a small business size standard of 1,300 
employees, Valkyrie Enterprises is the only one of the 
8 incumbents is no longer a small business under 
NAICS 336611

https://iq.govwin.com/neo/opportunity/view/247496
https://iq.govwin.com/neo/opportunity/view/246373


Status Update
FY 2025 Top 10 Small 
Business Opportunities

24© Deltek, Inc. All Rights Reserved.



FY 2024
Rank

Agency Program Name
Est. 

Value^
GovWin 

IQ ID
Status

1 Commerce
Professional Scientific and Technical Services Program 2 

Weather Domain (ProTech 2.0)
$8.0 B 205898

Awarded, under 
Protest

2 State Access $5.0 B 193020
Archived / 

Closed

3 Air Force
Air Education Training Command Base Operations Support 

Multiple Award Contract (AETC BOS MAC)
$4.0 B 241870 Under Evaluation

4
DOD 

USSOCOM
SOF Global Services Delivery (SOF GSD) $3.2 B 207172 On FY 2026 List

5 DHS
Cellular Wireless Managed Services for the Department of 

Homeland Security (CWMS 3.0)
$3.0 244497 On FY 2026 List

6 DHS Regional Multiple Award Construction Contracts III (RMACC III) $4.0B 191481 RFP Released

7 Treasury
Enterprise Case Management Solution Development Services 

(ECM SDS)
$0.3B 209418 Awarded

8 Energy Legacy Management Support Services (LMS) $1.0 B* 217344 RFP FY 2028*

9 Commerce Census Bureau Transformation Application Modernization (CenTAM) $1.0 B 237323 On FY 2026 List

10
USAID
State

Global Evaluation and Third Party Monitoring IDIQ Project (GLOE-TPM) TBD 229032
RFP FY 2026* - 

Uncertain future

Top 10 Small Business Opportunities FY 2025 Status

25© Deltek, Inc. All Rights Reserved.

* Deltek Estimate^ Values may have changed since last year’s report

https://iq.govwin.com/neo/opportunity/view/205898
https://iq.govwin.com/neo/opportunity/view/193020
https://iq.govwin.com/neo/opportunity/view/241870
https://iq.govwin.com/neo/opportunity/view/207172
https://iq.govwin.com/neo/opportunity/view/244497
https://iq.govwin.com/neo/opportunity/view/191481
https://iq.govwin.com/neo/opportunity/view/209418
https://iq.govwin.com/neo/opportunity/view/217344
https://iq.govwin.com/neo/opportunity/view/237323
https://iq.govwin.com/neo/opportunity/view/229032


Resources

26© Deltek, Inc. All Rights Reserved.



Deltek Webinars You Should Watch
All On Demand Unless Otherwise Noted – All Webinars are Free

27© Deltek, Inc. All Rights Reserved.

Webinar Series: FAR 2.0 with Edward 
DeLisle, a partner at Thompson Hine LLP:
» Demystifying FAR 2.0: Understand the 

Revolutionary FAR Overhaul
» FAR 2.0 Critical Update: New 

Developments You Can't Miss
» FAR 2.0 Fall Update: September 

Implementation Insights
» FAR 2.0 October Update: Latest 

Developments (October 9, 2025)

Navigating the New Administration 
Series:
» Administration Transition 2025: 

Impacts and Implications for 
Government Contractors

» Navigating the New Administration: 
Impacts & Opportunities Part 1

» Navigating the New Administration: 
Impacts & Opportunities Part 2

» Navigating the New Administration: 
Impacts & Opportunities Part 3

» Navigating the DOGE Era: Impacts and 
Strategies for Federal Government 
Contractors

» First 100 Days: The Trump 
Administration Agenda and Impacts on 
Government Contracting

Series Bid Process Best Practices with Red 
Team Consulting:
» Part 1: Keys to Building an Opportunity 

Pipeline
» Part 2: Making Sound Bid Decisions
» Part 3: The Power of Soft Skills in Proposal 

Management
» Part 4: Writing Past Performance and 

Resumes in Proposals
» Part 5: Developing Differentiation
» Part 6: Agile & Lean Proposal Development
» Part 7: How Capture and Proposals Differ for 

GWACs
» Part 8: Keys to Success with Orals
» Part 9: Streamlining your Approach to BD, 

Capture, and Proposal (October 23, 2025)

Top Opportunity Series FY 2026:
» Top 20 Unrestricted Federal Opportunities for 

FY 2026
» Top 10 Federal Set-Aside Opportunities for FY 

2026

Small Business Overview & Trends:
» Top SBIR/STTR Trends and Program Outlook for 2025 and Beyond
» Maximize Your 8(a) Potential: Top Trends for 2025
» Maximize Your SDVOSB Potential: Top Trends for 2025
» Maximize Your HUBZone Potential: Top Trends for 2025
» Maximize Your Woman-Owned Contracting Potential
» Federal Contracting 101: Answers to the Most Commonly Asked Questions

Teaming / Protests with Maria Panichelli, a partner at McCarter & English, LLP
» Mergers and Acquisitions: Key Considerations for GovCons
» Teaming for Federal Set-Asides: The When, Why, and How
» Getting Schooled in Subcontracting Part 1
» Getting Schooled in Subcontracting Part 2
» Pre-Award Protests: Your Secret Weapon for More Contract Opportunities

Stand Alone Webinars - Federal Overview:
» 2025 DoD Acquisition Reforms: Impact on Government Contractors
» Navigating the DOGE: Agency Reorgs, Contract Shifts, and Your Business 

Strategy
» Breaking Down the FY 2026 Federal Budget Request: Impacts and 

Opportunities for Government Contractors
» Federal MarketView 2025
» Market Conditions Update for Government Contractors - Q3 2025
» Decoding the One Big Beautiful Bill Act (OBBBA) Contractor Opportunities & 

Market Impact
» CMMC Compliance: Program Updates That Could Make or Break Your 

Contracts
» FedFocus (November 4, 2025)

Download the Slides for clickable links 
(found in the Resources Widget)  

and visit 

Deltek Webinars
More webinars added all the time!

https://event.on24.com/wcc/r/5096987/BDA7164035A5A2C72593C519DBACA8D0/6241890?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4870422/22730A874AADFEBE26BD7EAC46FCBB45/5945967?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4823189/D48515AC0B5E3AAF8705CE4639A24DC9/5899718?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/5028263/78E793963890E3022A9D3CE90949E66A/2792512?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4797914/85BDE8A0DD7F83775D8A4B1681D52950?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4797914/85BDE8A0DD7F83775D8A4B1681D52950?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4803261/CCFE47C52AB8F57BC6927BCD4FB35351?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4803261/CCFE47C52AB8F57BC6927BCD4FB35351?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4832926/EBE610FD86503C51F806899F620A557E?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4832926/EBE610FD86503C51F806899F620A557E?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4808154/C063E7231F1068667120FE36BE86FEB8?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4808154/C063E7231F1068667120FE36BE86FEB8?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4851792/47464680589C5042C86E039DE46A949B?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4851792/47464680589C5042C86E039DE46A949B?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4851792/47464680589C5042C86E039DE46A949B?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4851792/47464680589C5042C86E039DE46A949B?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4808182/33B5B75C647C6138B31447E0867D4852?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4808182/33B5B75C647C6138B31447E0867D4852?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4797393/F0D5ECC0D0BA111803981580E3463DAC?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4797393/F0D5ECC0D0BA111803981580E3463DAC?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4797393/F0D5ECC0D0BA111803981580E3463DAC?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4844539/6965B8F5929D92AFA0B025F5191A386E?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4844539/6965B8F5929D92AFA0B025F5191A386E?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4844539/6965B8F5929D92AFA0B025F5191A386E?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4844539/6965B8F5929D92AFA0B025F5191A386E?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4968320/5D2048FD6977177E610EFDD808F7B050?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4968320/5D2048FD6977177E610EFDD808F7B050?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4968320/5D2048FD6977177E610EFDD808F7B050?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
https://event.on24.com/wcc/r/4968320/5D2048FD6977177E610EFDD808F7B050?sourceid=25&utm_source=webinar-presentation&utm_medium=event&utm_campaign=GWIQ-TopSetAsides-20251007&partnerref=event_webinar-presentation_GWIQ-TopSetAsides-20251007
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Federal Small Business 
Opportunities*

Small Business Spending 
Data*

Small Business 
Innovative Research 

(SBIR)*

Teaming for Federal 
Contracting*

Federal Agency 
Research*

Government Contacts 
Research*

Small Business 
Contracting 

News and Analysis
Small Business Events

Small Business Training 
and Guides*

Small Business 
Administration 

Resources

Additional Small Business 
Contracting Resources

Small Business 
Contracting Oversight 

and Compliance

Small Business Resources for 
Government Contractors*
https://iq.govwin.com/neo/small-business-resources
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*Some information requires a GovWin subscription.

https://iq.govwin.com/neo/small-business-resources


The Trump Administration has issued 
executive orders and memos that could 
impact federal and SLED contractors. As 

policies evolve, contractors must stay 
informed, maintain contract performance 
and develop strategic agility. Access free 

resources to understand the most impactful 
actions and their implications.

Looking for more insights and support?
Become a GovWin IQ customer

RESOURCE HUB: Trump Administration 2025:
GovCon Impacts
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FAR 2.0 Under Trump:
Key Updates

Decoding the One Big 
Beautiful Bill Act

The Latest Trump
Administration Policies

Navigating the New 
Administration: Impacts 

and Opportunities

FY 2026 Federal 
Budget Blueprint

Practical Advice for
Government Contractors

During Presidential
Transitions

Winning SLED 
Contracts In Today’s 
GovCon Landscape

Tracking Terminated
Contracts

Trump 2.0: News
Updates and Analysis

https://info.deltek.com/Trump-Administration-2025-Resources#feature
https://info.deltek.com/Trump-Administration-2025-Resources


Topic Links

CMMC 2.0

Federal Register: Defense Federal Acquisition Regulation 
Supplement: Assessing Contractor Implementation of 
Cybersecurity Requirements (DFARS Case 2019-D041)

DOD CIO 'About' CMMC

FAR Overhaul

FAR Part 19 Change Summary

FAR Parts and Agency Deviations

Revolutionary FAR Overhaul (RFO)

Federal Acquisition Regulations (FAR)

Defense Federal Acquisition Regulation Supplement 
(DFARS)

Procurement 
Sites & 

Support

Procurement Integrated Enterprise Environment (PIEE)

Acquisition Resource Center (ARC)

DHS Acquisition Procurement Forecast System (APFS)

System for Award Management (SAM.gov)

APEX Accelerators or APTAC aka aka PTAP aka PTAC

Additional Resources (not webinars)
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Topic Links

New 
Administration

Department of Government Efficiency (DOGE) Contract 
Termination List

Executive Order # 14240, Eliminating Waste and Saving 
Taxpayer Dollars by Consolidating Procurement

Executive Order # 14275, Restoring Common Sense To 
Federal Procurement

Anatomy of a Federal Shutdown: FY 2026 Edition (Deltek 
Report, requires GovWin IQ Subscription)

SB Size 
Standards

Federal Register: Small Business Size Standards: Monetary-
Based Industry Size Standards

SBA Table of Small Business Size Standards

Teaming

SBA All Small Mentor Protégé Program (ASMPP)

SBA Active mentor-protege agreements

DOD Mentor-Protégé Program (MPP)

Deltek’s Federal Government Contracting Analysis – articles, reports, presentations and links to webinars on a wide range of Federal Topics 
(Most items are free, some reports may require GovWin IQ subscription, Federal Market Analysis subscription or fee for non-subscribers)
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https://www.acquisition.gov/far-overhaul/far-part-deviation-guide
https://www.acquisition.gov/far-overhaul
https://www.acquisition.gov/browse/index/far
https://www.acquisition.gov/dfars
https://www.acquisition.gov/dfars
https://piee.eb.mil/
https://piee.eb.mil/
https://piee.eb.mil/
https://piee.eb.mil/
https://www.nsaarc.net/dashboard
https://apfs-cloud.dhs.gov/
https://www.sam.gov/
https://www.apexaccelerators.us/#/
https://doge.gov/savings
https://doge.gov/savings
https://www.whitehouse.gov/presidential-actions/2025/03/eliminating-waste-and-saving-taxpayer-dollars-by-consolidating-procurement/
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https://business.defense.gov/Programs/Mentor-Protege-Program/
https://www.sba.gov/document/support-active-mentor-protege-agreements
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https://iq.govwin.com/neo/marketAnalysis/index?researchMarket=PFMAP


» $000, Dollars in Thousands
» $B, Dollars in Billions
» $K, Dollars in Thousands
» $M, Dollars in Millions
» A&AS, Advisory and Assistance Services
» Admin or Adm, Administrative
» AEDC, Arnold Engineering Development Complex
» AETC, Air Education Training Command
» AFC, Army Futures Command
» AFTC, Air Force Test Center
» AI, Artificial Intelligence
» AI/ML, Artificial Intelligence & Machine Learning
» ANC, Alaska Native Corporation
» APFS, Advanced Planning Forecast System
» APTAC, Association of Procurement Technical 

Assistance Centers
» ARC, Acquisition Research Center
» ARC, Acquisition Resource Center
» ASMPP, All Small Mentor-Protégé Program
» AvMC, Army Futures Command (AFC) DEVCOM 

Aviation and Missiles Center
» BD, Business Development
» BI, Business Intelligence
» BIC, Best In Class
» Bldgs, Buildings
» BLOS, Beyond Line of Sight
» BMO, Building Maintenance and Operations
» BOS, Base Operations Support
» BPA, Blanket Purchase Agreement
» BW, Biological Weapons

» C3PAO, Cybersecurity Maturity Model Certification 
Certified Third-Party Assessor Organization

» C4I, Command, Control, Communication, Computers 
& Intelligence

» CBP, Customs and Border Protection
» CCDC, Army Combat Capabilities Development 

Command  (now DEVCOM)
» CD, Counter drug
» CenTAM, Census Bureau Transformation Application 

Modernization
» CHT, Collection Holding and Transfer
» CI, Counterintelligence
» CIO, Chief Information Officer
» CIO-SP, Chief Information Officer Solutions and 

Partners
» CLIN, Contract Line Item Number
» CMMC, Cybersecurity Maturity Model Certification 
» COTS, Commercial-Off-the-Shelf
» CTG, Cyberspace Test Group
» CUI, controlled unclassified information 
» CW, Chemical Weapons
» CWMS, Cellular Wireless Managed Services
» D&D, Denial & Deception
» DEVCOM, Combat Capabilities Development 

Command (was CCDC)
» DFARS, Defense Federal Acquisition Regulation 

Supplement
» DHS, Department of Homeland Security
» DIA, Defense Intelligence Agency
» DIB, Defense Industrial Base

» DIBCAC, Defense Industrial Base Cybersecurity 
Assessment Center

» DIE, Defense Intelligence Enterprise
» DLA, Defense Logistics Agency
» DO, Delivery Order
» DOD, Department of Defense
» DOGE, Department of Government Efficiency
» ECM SDS, Enterprise Case Management Solution 

Development Services
» ELINT, Electronic Intelligence
» EO, Executive Order
» Ex, Exception (NAICS)
» FAR, Federal Acquisition Regulation 
» FCI, Federal contract information 
» FEMA, Federal Emergency Management Agency
» FMA, Federal Market Analysis
» FOPR, Fair Opportunity Proposal Request
» FSA, GovWin's Federal Spending Analytics
» FSIII, FirstSource III
» FSSI, Federal Strategic Sourcing Initiative
» FY, Fiscal Year

Acronyms / Abbreviations from Today’s Webinar
(Slide 1 of 3, A-F)
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» GAO, Government Accountability Office
» GLOE-TPM, Global Evaluation and Third Party 

Monitoring IDIQ Project
» GovCon, Government Contractors
» GSA, General Services Administration
» HCaTS, Human Capital and Training Solutions
» HHS, Department of Health and Human Services
» HOPSS, HHS One Professional Services Solution
» HUB, Historically Underutilized Business Zone
» HUBZone, Historically Underutilized Business Zone
» HUMINT, Human Intelligence
» HVAC&R, Heating, Ventilation, Air Conditioning and 

Refridgeration
» I2, Identity Intelligence
» IBCS, Integrated Battle Command System
» ID/IQ, Indefinite Delivery, Indefinite Quantity
» IDIQ, Indefinite Delivery, Indefinite Quantity
» IMINT, Imagery Intelligence
» IRS, Internal Revenue Service
» ISR, Intelligence, Surveillance, and Reconnaissance 
» IT, Information Technology
» IV&V, Independent Verification and Validation
» JV, Joint Venture
» LCATs, Labor Categories
» LLC, Limited Liability Company
» LLP, Limited Liability Partnership
» LMS, Legacy Management Support
» Log, Logistics
» LRAE, Long Range Acquisition Estimate
» M&O, Management & Operations

» M&S, Modeling and Simulation
» MAC, Multiple Agency Contract
» MAC, Multiple Award Contract
» MACM, Multiple Award Contract for Modifications
» MAS, Multiple Award Schedule
» MASINT, Measurements and Signatures Intelligence
» Mgmt, Management
» MIA, Missing in Action
» ML, Machine Learning
» MP, Mentor-Protégé
» MPP, Mentor-Protégé Program
» MPT, Micro-purchase threshold
» MRAS, Market Research As a Service
» N/A, Not Applicable
» NAICS, North American Industrial Classification 

System
» NAVSEA, Naval Sea Systems Command
» NIH, National Institutes of Health
» NIST, National Institute of Standards and Technology
» NSWC, Naval Surface Warfare Center
» O&M, Operations and Maintenance
» OASIS, One Acquisition Solution for Integrated 

Services
» OBBBA, One Big Beautiful Bill Act
» OFPP, Office of Federal Procurement Policy
» Opp, Opportunity
» ORSA, Operations Research Systems Analyst
» OSINT, Open Source Intelligence
» PACTS III, Program Management Administrative 

Clerical and Technical Services III

» PIEE, Procurement Integrated Enterprise Environment
» PIF, Prototype Integration Facility
» PM, Program / Project Manager
» POW, Prisoner of War
» PR, Personal Recovery
» Prof, Professional
» Prof Svcs, Professional Services
» ProTech, Professional Scientific and Technical 

Services Program
» PTAC, Procurement Technical Assistance Center
» PTAP, Procurement Technical Assistance Program
» PWS, Performance Work Statement
» Q&A, Questions and Answers
» Q1, Q2, Q3, Q4, Fiscal or Calendar Quarter
» R&D, Research and Development
» RFI, Request for Information
» RFO, Revolutionary FAR Overhaul
» RFP, Request for Proposals
» RFQ, Request for Quote
» RMACC, Regional Multiple Award Construction 

Contract

Acronyms / Abbreviations from Today’s Webinar
(Slide 2 of 3, G-R)
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» S3I, Simulation, Systems Engineering and Integration 
Directorate

» SAFe, Scaled Agile Framework
» SAM, System for Award Management
» SAT, Simplified Acquisition Threshold
» SB, Small Business
» SBA, Small Business Administration
» SBIR, Small Business Innovation Research
» SCI, Sensitive Compartmented Information
» SCS, SOF Core Support
» SDB, Small Disadvantaged Business
» SDVOSB, Service Disabled Veteran Owned Small 

Business
» SEWP, Solutions for Enterprise-Wide Procurement
» SHIELD, Scalable Homeland Innovative Enterprise 

Layered Defense 
» SIA, Solutions for Intelligence Analysis
» SIGINT, Signals Intelligence
» SIN / SINs, Special Identification Number
» SLED, State, Local and Education
» SMCDA, Social Media and Crowd-Sourced Data
» SOAR, Scientific, Operations, and Administrative 

Resources
» SOCOM, United States Special Operations Command
» SOE TLS, Special Operational Equipment Tailored 

Logistics Support 
» SOF, Special Operations Forces
» SOF/PR, Special Operations Forces/Personnel 

Recovery
» SOFGSD, Special Operations Forces (SOF) Global 

Services Delivery (GSD)
» SOW, Statement of Work
» SP, Special Publication
» SPRS, Supplier Performance Risk System
» SPS, Systems and Program Support
» STEM, Science, Technology, Engineering, and Math
» STOPS, Scientific Technical and Other Professional 

Support
» STTR, Small Business Technology Transfer
» Sub, Subcontracting
» Svcs, Services
» SWMS, SOCOM-Wide Mission Support
» T&M, Time and Materials
» TBD, To Be Determined
» Tech, Technical
» TECHINT, Technical Intelligence
» Temp, Temporary
» TM, Target Materials
» TMAS, Technical and Management Advisory Services 

for the Test Enterprise
» TOC, Transnational Organized Crime
» TW, Test Wing
» UGF, Underground Facility
» UNK, Unknown
» UNR, Unrestricted Competition
» US/U.S., United States
» USAID, United States Agency for International 

Development
» USCB, United States Census Bureau

» USSOCOM, United States Special Operations 
Command

» WMD, Weapons of Mass Destruction 
» WOSB, Woman-owned small business
» Yrs, Years

Acronyms / Abbreviations from Today’s Webinar
(Slide 3 of 3, S-Z)
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Includes Full and Open and 
Partial Small Business Set-Aside

Exclusive to Small Business and 
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